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Voice (     ) memo / Up button
3. Press the shutter button to start recording and voice will

be recorded to the still image for 10 seconds. 
While the voice is recording, the recording status window
will be displayed as shown alongside.

4. The recording can be stopped by pressing the shutter
button again.

5. The (        ) icon will be displayed on the LCD monitor
after voice memo recording has finished. 
- Voice memos can’t be recorded onto movie clip files.
- A distance of 40cm between you and the camera
(microphone) is the best distance to record sound.

- The voice memo will be saved in ҭ.wav format, but has
the same file name as the still image to which it
corresponds.

- If you add a new voice memo to the still image that already has a voice memo, the
existing voice memo will be erased.

Play & Pause (          ) / Down button

■ In Play mode, the play & pause/ down button works as follows:

- If the menu is displayed
Press the DOWN button to move from the main menu to a sub menu, or to move down the
sub menu cursor.

- If a still image with a voice memo, a voice file, or a movie clip is playing
In Stop mode : Plays a still image with a voice memo, a voice file, or a movie clip.
During playback : Temporarily stops playback.
In Pause mode : Resumes playback

100-0009

STOP:SHUTTER

100-0009

[Voice recording is stopped]

100-0004 

[Voice recording is paused][Voice recording is playing]

100-0004 100-0004
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Delete (     ) button
■ This deletes images stored on the memory card.

● Before deleting images from the camera, you should protect or download images to your
computer that you wish to keep.

INFORMATION 

● Deleting Images in Thumbnail Display Mode
1. Use the UP, DOWN, LEFT, and RIGHT buttons to select the image you want to delete,

and then press the DELETE (        ) button.
2. The following message will be displayed on the LCD monitor.
3. Select the submenu values by pressing the UP/DOWN button and then press the OK

button.
If [Delete] is selected : deletes the selected images.
If [Cancel] is selected : cancels "Delete Image".

● Deleting Images in Play Mode
1. Select an image that you want to delete by pressing the

LEFT / RIGHT button and press the DELETE(         )
button.

2. A message will display as shown alongside on the LCD
monitor.

3. Select the submenu values by pressing the UP/DOWN
button and then press the OK button.
If [Delete] is selected : deletes the selected images.
If [Cancel] is selected : cancels "Delete Image".

100-0009

Delete?

Delete

Cancel

Confirm:OK

Press the 
DELETE button.

Delete?

Delete

Cancel

Confirm:OK
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Left / Right / Menu / OK button
■ LEFT / RIGHT/ MENU/ OK buttons activate the following.

- LEFT button : While the menu is showing, press the LEFT button to select the menu tab
to the left of the cursor.

- RIGHT button : While the menu is showing, press the RIGHT button to select the menu
tab to the right of the cursor, or to move an secondary menu.

- MENU button : When you press the MENU button, the play mode menu will be displayed
on the LCD monitor. Pressing it again will return the LCD to the initial
display.

- OK button : When the menu is displayed on the LCD monitor, the OK button is used
for confirming data that is changed by using the 5 function button.
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Album button

Select

Slide

Add

Remove

■ You can organise the captured still images into albums by
using the Album  button.

■ This camera has 8 albums and each album can take up to
100 images. 

■ The album menu loading time depends on the memory
card type.  

● Inserting still images into the album
1. Select an album.
2. Select the [Add] menu by pressing the Up/Down button

and press the Right button. 

■ How to use the album

● Selecting the album
1. In the play mode, press the Album button. 
2. Select the [Select] menu by pressing the Up/Down

button and press the Right button. 

3. Select a desired album by pressing the
Up/Down/Left/Right buttons and press the OK button. 

-0009

Exit:MENU Move:      ��

Select

Slide

Add

Remove

Set:OK

Select

Slide

Add

Remove

Select:T Set:OK



Select:T Set:OK

Select

Slide

Add

Remove

Select:T Set:OK

Select

Slide

Add

Remove

Set:OK
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Album button

Select

All Pics

3. Select the still images you wish to add by pressing the
Up/Down/Left/Right buttons and press the Zoom T
button.       marks are displayed on the selected images.

※ To cancel the selection, press the Zoom T button again. 

4. Press the OK button and a confirmation window will
display. Select a desired sub menu by pressing the UP/
DOWN button and press the OK button.
- [Add] : Inserts the selected images into the album.  
- [Cancel] : Cancels the inserting images.

● Removing still images from the album
1. Select an album.
2. Select [Remove] menu by pressing the Up/Down button

and press the Right button. 
3. Select a desired sub menu and press the OK button. 

- [All] : All of the still images in the album will be
removed. 

- [Select] : Specific still images in the album can be
removed. 

※ If [Select] is selected
- Select images that you want to remove by pressing the
Up/Down/Left/Right buttons and press the 
Zoom T button.       marks are displayed on the
selected images. 

4. Press the OK button and a confirmation window will
display. Select a desired sub menu by pressing the UP/
DOWN button and press the OK button.
- [Remove] : Removes the selected images from the

album.  
- [Cancel] : Cancels the removing images.

※ The removed images are not deleted from the memory,
but just removed from the album.

Add?

Add

Cancel

Confirm:OK

Select:T Set:OK

Remove?

Remove

Cancel

Confirm:OK

Select

Slide

Add

Remove

Select:T Set:OK
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Album button

● If an image is deleted from the memory, the image doesn’t display on an album. 
● An image can’t be added twice into the same album. 
● An image can be added into the different albums. 

INFORMATION

● Playing back the albums
◎ Playing back all of the albums
1. Select [All] menu and press the OK button. 

All of the albums will be selected. 
2. Select [Slide] menu by pressing the Up/Down button and

press the Right button. 
※ You can select [Start], [Interval], [Repeat] and [Effect]

menus. 
- [Start] : Start the slide show
- [Interval] : Set the slide show play interval
- [Repeat] : Choose to repeat the slide show after

finishing the first cycle. 
- [Effect] : Unique screen effects can be used for the

slide show.
3. Select [Start] menu by pressing the Up/Down button and

press the OK button to start the slide show. 
4. Press the MENU/OK button and the slide show will stop.

◎ Playing a desired album
1. Select a desired album and press the OK button. 
2. Select [Slide] menu by pressing the Up/Down button and

press the Right button. 
※ You can select [Start], [Interval], [Repeat] and [Effect]

menu.
3. Select the [Start] menu and press the OK button to start

the slide show. 
4. Press the MENU/OK button and the slide show will stop.

Select

Slide

Add

Remove

Exit:MENU Move:      

Start

Interval 1 sec

Off

Cancel

Repeat

Effect

Select

Slide

Add

Remove

Exit:MENU Move:      ��

��

Select

Slide

Add

Remove

Move:     Set:OK 

Start

Interval 1 sec

Off

Cancel

Repeat

Effect

Select

Slide

Add

Remove

Exit:MENU Move:      ��

��
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Setting up the play back function using the LCD monitor

Icon Main menu Sub menu Secondary menu Page

Start -

Interval 1, 3, 5, 10sec

Slide Repeat Off / On p.79

Cancel

Effect 1 ~ 4, Random

Select 

All Pics

Select -

All Pics -

2272X1704 -

2048X1536 -

1600X1200 -

1024X768 -

640X480 -

User Image -

B&W Red

Effect Sepia Green p.84

Negative Blue

Right 90˚ -

Left 90˚ -

Rotate 180˚ - p.85

Horizontal -

Vertical -

■ PLAY mode functions can be changed by using the LCD monitor. In the PLAY mode,
pressing the MENU button displays the menu on the LCD monitor. The menus you can set
up in Play mode are as follows. To capture an image after setting up the play menu, press
the PLAY mode button or shutter button.

p.81

p.82

p.83

Protect Unlock / Lock

Delete

Resize

Effect
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Setting up the play back function using the LCD monitor

Icon Main menu Sub menu Secondary menu Page

One Pic -

All Pics -

No -

Yes -

Auto

Postcard

Card

4X6

L

2L

Letter

A4

A3 p.91

Auto

Full

1

2

4

8

9

16

Auto Set

Custom Set

Images

Layout

Size

Icon Main menu Sub menu Secondary menu Page

Standard Select/ All Pics/ Cancel

DPOF Index No/ Yes p.85

Size Select/ All Pics/ Cancel

No -

Yes -
p.88

p.90

p.91

■ This menu is available while the camera is connected to a PictBridge supporting printer
(direct connection to the camera, sold separately) with a USB cable.

Copy to Card
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Setting up the play back function using the LCD monitor
Icon Main menu Sub menu Secondary menu Page

Auto

Plain

Photo

Fastphoto

Auto

Draft

Normal

Fine

Auto

Date Off

On

Auto

File Name Off

On 

Standard -

Index - 

No -

Yes -

No -

Yes -

Print

Custom Set

p.92

p.92

p.93

p.91

DPOF Print

Reset

※ Menus are subject to change without prior notice.

Quality

Type
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Starting the slide show

● The loading time depends on the image size and quality.
● While the slide show is playing, only the first frame of a MOVIE file is displayed.
● While the slide show is playing, the voice recording file will not display. 

INFORMATION

● Start the slide show : The slide show can start only in the [Start] menu.
1. Use the Up/Down buttons to select the [Start] menu.
2. Press the OK button to start the slide show.
- Press the Pause button to pause the slide show.
- Press the Pause button (              ) again to resume the
slide show.

- To stop the slide show, press the play & pause button,
and then press the LEFT or RIGHT button.

■ Images can be displayed continuously at pre-set intervals.
You can view the slide show by connecting the camera to an external monitor.
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Slide] menu tab.

● Setting play interval: Set the slide show play interval.
1. Select the [Interval] sub menu by pressing the UP/DOWN

button and press the RIGHT button.
2. Use the Up/Down buttons to select the desired interval.
3. Press the OK button to save the configuration.

● Repeat setting : Setting the slide show to repeat after the first cycle.
1. Use the Up/Down buttons to select the [Repeat] menu and

press the Right button.
2. Use the Up/Down buttons to select the desired sub menu.

[On] selected : The slide show is repeated until cancelled.
[Off] selected : The slide show is closed after one cycle.

3. Press the OK button to save the configuration.

Start
Interval
Repeat
Effect

Slide

Move: Set:OK��

1 sec
Off
Cancel

Start
Interval
Repeat
Effect

Slide

Back:◀ Set:OK

1 sec
3 sec
5 sec
10 sec

Start
Interval
Repeat
Effect

Off
On

Slide

Back:◀ Set:OK
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Starting the slide show
● Configure slide show effects: Unique screen effects can be used for the slide show.

1. Select the [Effect] sub menu by pressing the UP/ DOWN
button and press the RIGHT button.

2. Use the Up/Down Button to select the type of effect.
[Cancel] : Normal display.
[Effect 1] : Image is displayed slowly.
[Effect 2] : Image is displayed slowly from the centre

outwards.
[Effect 3] : Image moves from the top left.
[Effect 4] : The image slides diagonally from top left to bottom right. 
[Random] : The image slides irregularly.

3. Press the OK button to confirm the setting.

Start
Interval
Repeat
Effect

Cancel
Effect 1
Effect 2
Effect 3
Effect 4

Slide

Back:◀ Set:OK
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Protecting images
■ This is used to protect specific shots from being accidentally erased (Lock).

It also unprotects images that have been previously protected (Unlock).

● Protecting Images
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Protect]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select ] : Selection window for an image to be

protected/released is displayed.
- Up/Down/Left/Right : Select an image
- Zoom W/T Button : Protect/release the image
- Menu Button : Your changes will be saved and

the menu will disappear.
[All Pics] : Protect/release all saved images
- Zoom W/T Button : Protect/release the images
- Menu Button : Your changes will be saved and the

menu will disappear.

- If you protect an image, the protect icon will be displayed
on the LCD monitor. (An unprotected image has no
indicator)

- An image in LOCK mode will be protected from the
delete function or [Delete] functions, but will NOT be
protected from the [Format] function.

Protect

Exit:MENU Move:��

Select
All Pics

100-0003

Set:OK

W◀ Unlock          ▶T

W◀ Unlock             ▶T

Set:OK
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Deleting images
■ Of all the files stored in the memory card, the unprotected files in the DCIM subfolder will be

deleted. Remember that this will permanently delete unprotected images. 
Important shots should be stored on a computer before deletion takes place. 
The startup image is stored in the camera's internal memory (i.e., not on the memory card)
and it will not be deleted even if you delete all files on the memory card.

● Deleting images
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Delete]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select] : Selection window for an image to delete is

displayed.
- Up/Down/Left/Right : Select an image
- Zoom T Button : Select the image for deletion.

(       mark)
- OK Button : Press the OK Button to display the

confirmation message. Select the
[Delete] menu and press the OK
button to delete       marked
images. 

[All Pics] : Displays confirmation window. Select the
[Delete] menu and press the OK button to
delete all unprotected images. If there aren’t
protected images, all the images are deleted
and a [No Image!] message will display. 

4. After deletion, the screen will be changed to the play
mode screen.

Select:T
Del:OK

Del:OK

Delete?

Delete

Cancel

Confirm:OK

Delete

Exit:MENU Move:��

Select
All Pics
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Resize

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Resize]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.

■ Change the resolution (size) of pictures taken. Select [User image] to save an image to be
the start-up image. The resized image will have a new file name.

● A large sized image can be resized to a smaller sized image, but not vice versa.
● Only JPEG images can be resized. Movie clip(AVI) and Voice recording(WAV) files can’t

be resized.
● You can change the resolution of only those files compressed in the JPEG 4:2:2 format.
● The resized image will have a new file name. The [User Image] image is stored not on the

memory card but on the internal memory.
● Only two [User Image] images can be saved. If you save a new [User Image] image, the

existing startup image will be deleted in order.
● If the memory capacity is insufficient to store the resized image, a [Card Full!] message

will display on the LCD monitor and the resized image will not be stored.

INFORMATION

Resize 2272X1704 2048X1536 1600X1200 1024X768 640X480 User image

5M O O O O O O

4M X O O O O O

3M X X O O O O

2M X X X O O O

1M X X X X O O

VGA X X X X X O

● Image Resize Types

Resize

Exit:MENU Move:��

2272 X 1704
2048 X 1538
1600 X 1200
1024 X 768
640 X 480
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Rotating an image
■ You can rotate the stored images by various degrees. Once the playback of the rotated

picture is finished, it will switch back to the original state.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Rotate]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button.

4. Press the OK button and the rotated image will be displayed. 
If you display the rotated image on the LCD monitor, empty spaces may appear to the left
and right of the image.

[Right 90˚] : 
Rotate picture in a clock-
wise direction

100-0003

[Left 90˚] : 
Rotate picture in a counter-
clock-wise direction

100-0003 100-0003

[180˚] : 
Rotate picture 180 degrees

[Horizontal] : 
Rotate picture horizontally

100-0003

[Vertical] : 
Rotate picture vertically 

100-0003

Rotate

Exit:MENU Move:��

Right 90°
Left 90°
180°
Horizontal
Vertical
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Effect

■ DPOF(Digital Print Order Format) allows you to embed printing information on your memory
card’s MISC folder. Select the pictures to be printed and how many prints to make.

■ The DPOF indicator will display on the LCD monitor when an image that has DPOF
information plays back. Images can then be printed on DPOF printers, or at an increasing
number of photo labs.

■ This function is not available for Movie clips and Voice recording files.

■ By using the camera’s digital processor, it is possible to add special effects to your images.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [Effect]

menu tab.
3. Select a desired sub menu by pressing the UP/ DOWN

button.
[B & W] : Converts the image to black and white.
[Sepia] : Captured images will be stored in a sepia

tone
(a gradient of yellowish brown colours).

[Red] : Captured images will be stored in a red tone. 
[Green] : Captured images will be stored in a green tone.
[Blue] : Captured images will be stored in a blue tone.
[Negative] : Save the image in negative mode.

4. Press the OK button and the changed file save as a new file name. 

DPOF 

Effect

Exit:MENU Move:��

B & W
Sepia
Red
Green
Blue
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DPOF : Standard
■ This function allows you to embed print quantity information on a stored image.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]

menu tab.
3. Select the [Standard] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select] : Selection window for an image to print is

displayed.
- Up/Down/Left/Right : Select an image to print.
- Zoom W/T Button : Select the number of prints.
[All Pics] : Configure number of prints for all pictures

except movie and voice files.
- W/T button : Select a number of prints
[Cancel] : Cancel the print setup.

5. Press the OK button to confirm the setting.
If an image carries DPOF instructions, the DPOF indicator
(         ) will show.

1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]

menu tab.
3. Select the [Index] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button.
If [No] is selected : Cancel the index print setting.
If [Yes] is selected : The image will be printed in index format.

5. Press the OK button to confirm the setting.

DPOF : Index

■ Images (except for movie clips and voice file) are printed as index type.

Standard
Index
Size

Select
All Pics
Cancel

DPOF

Back:◀ Set:OK

Set:OK

W◀ 0 Prints        ▶T

W◀ 0 Prints            ▶T

Set:OK

Standard
Index
Size

No
Yes

DPOF

Back:◀ Set:OK
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DPOF : Print size

● Setting the Print Size
1. Press the play mode button and press the menu button.
2. Press the LEFT/ RIGHT button and select the [DPOF]

menu tab.
3. Select the [Size] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Select] : Selection window for an image to be changed

printed size is displayed.
- Up/Down/Left/Right : Select an image.
- Zoom W/T Button : Change the print size.
- OK button : Your changes will be saved and the

menu will disappear.
[All Pics] : Change print size of all saved images.
- W/ T button : Select a print size
- OK button : Confirm the changed setting.
[Cancel] : Cancel all of the print size settings.
※ DPOF [Size] secondary menu : Cancel, 3X5, 4X6, 5X7,

8X10

■ You can specify the print size when printing images stored on the memory card.
The [Size] menu is available only for DPOF 1.1 compatible printers.

Standard
Index
Size

Select
All Pics
Cancel

DPOF

Back:◀ Set:OK

Set:OK

W◀ Cancel         ▶T

W◀ Cancel            ▶T

Set:OK
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Copy To Card
■ This enables you to copy image files to the memory card.

● Copying to the Memory Card
1. Press the play mode button and press the menu button.
2. Select the [Copy to Card] menu tab by pressing the LEFT/

RIGHT button.
3. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [No] : Cancels "Copy to Card".
- [Yes] : All images saved in the internal memory are

copied to the memory card after the [Please Wait!] message is displayed. 
After copying has been completed, the screen will return to play mode.

● When this menu is selected without inserting a memory card, you can select the 
[Copy to Card] menu but the menu can’t be run.

● If there is not enough space available in the memory card to copy saved images in the
internal memory (50MB), the [Copy to Card] command will copy only some of the images
and display [Card Full!] message. Then the system will return to the playback mode.
Please be sure to delete any unnecessary images to free up space before inserting the
memory card into the camera.

● When you move the images that are stored in the internal memory by doing 
[Copy to Card] to the card, the next number of file names will be created in the card to
avoid duplication of the file name. If the last file in the memory card is SSL10010.jpg, 
the copied file names start from SSL10011.jpg. After completing [Copy to Card], the last
stored image of the last copied folder is displayed on the LCD monitor. 

INFORMATION

Copy To Card

Exit:MENU Move:��

No
Yes
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PictBridge

[Using the USB cable with Cradle]

[Using the USB cable with Camera]

■ Connecting the Camera to a Printer

● Using the USB cable with Cradle : 
Connect the camera and the cradle. Connect the cradle to a printer’s USB port with the
supplied USB cable. 

● Using the USB cable with Camera : 
Connect the camera to a printer’s USB port with the supplied USB cable.

● Setting up the camera for connection with the printer
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select [Setup] menu

tab.
3. Select [USB] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select [Printer] menu by pressing the UP/ DOWN button

and press the OK button.

※ If you selected [Computer] in Step 4, when you connect the camera to your printer, the
[Connecting Computer] message will display and the connection will not be established.
In this case, disconnect the USB cable, and then follow the procedure from Step 2 and
onward.

■ You can use the USB cable to connect this camera to a printer that supports PictBridge (sold
separately) and print the stored images directly. Movie clips and voice files cannot be printed.

Format
Date&Time
Imprint
Sound
USB

Computer
Printer

Setup

Back:◀ Set:OK
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PictBridge : Picture Selection

Images : Select the pictures to be printed.

Printer Setup : Setting up printing(Auto Set/ Custom Set)

Print : Printing pictures

DPOF Print : Printing the DPOF files

Reset : Initializing the PictBridge functions

■ You can set up the following settings from the PictBridge menu.

[When [One Pic] is selected] [When [All Pics] is selected]

- Press the Up/Down button to select the number of prints. 
- Use the Left/Right button to select another picture and select the number of prints for
another picture.

- After setting the number of prints, press the OK button to save.
- Press the Shutter button to return to the menu without setting the number of prints.

0

10

● Setting the Number of Copies to Print
- Select [One Pic] or [All Pics]. A screen where you can set the number of copies to print will
appear as shown below.

PREV ◀▶ NEXT

▲

▼

■ Select pictures to print
1. The [Images] menu will appear.
2. Use the UP and DOWN buttons to select the desired

submenu value, and then press the OK button.
When [One Pic] is selected : The PictBridge function will

be applied only to the
picture currently displayed.

When [All Pics] is selected : The PictBridge function will
be applied to all pictures,
excluding movie clips and voice files.

Exit:Shutter Set:OK

0
▲

▼

Exit:Shutter Set:OK

Images

Move:��

One Pic
All Pics
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PictBridge : Print Setting

Menu

Size Setting the size of the printing paper Auto, Postcard, Card, 4X6, L, 2L, Letter, A4, A3

Setting the number of pictures to be 

printed on a sheet of paper

Type Setting the quality of the printing paper Auto, Plain, Photo, Fastphot

Setting the quality of the picture to be 

printed

Date Setting whether to print the date Auto, Off, On

File Name Setting whether to print the file name Auto, Off, On

■ AUTO SET
1. Use the LEFT and RIGHT buttons to select the 

[Auto Set] menu tab.
2. Use the UP and DOWN buttons to select the desired

submenu value, and then press the OK button.
[No] : [Custom Set] values are kept.
[Yes] : All values in the [Custom Set] are automatically

changed.

※ Some menu options are not supported in all manufacturer and printer models. 
If not supported, the menus are still displayed in the LCD, but are not selectable.

※ If the setting values are not changed in the automatic/manual setting, the setting values are
automatically kept.

1. Use the LEFT and RIGHT buttons to select the 
[Custom Set] menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the RIGHT button.

3. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button. 

■ Custom Set : You can select the Paper Size, Print Format, Paper Type, Print Quality, Date
Print, and File Name Print menus for printed pictures.

Function

Auto, Draft, Normal, Fine

Auto, Full, 1, 2, 4, 8, 9, 16

Sub menu

Layout

Quality

● The menus you can set up are as follows:

Auto Set

Move:��

No
Yes

Size
Layour
Type
Quality
Date

Auto
Auto
Auto
Auto
Auto

Custom Set

Move:��
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Cancel:OK
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PictBridge : Printing
■ Printing Pictures

1. Use the LEFT and RIGHT buttons to select the [Print]
menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[Standard] : Print the pictures stored in the memory card

in set numbers. One picture is printed on
one piece of paper.

[Index] : Print multiple images on one sheet of paper.
3. The screen shown on the right will appear and the picture

will be printed. If no picture is selected, the [No image!]
message will be displayed. Press the Menu/OK button
while printing to cancel the printing and the [Print] menu
is displayed.

※ Number of pictures in an index print varies depends on the
printer used.

1. Use the LEFT and RIGHT buttons to select the 
[DPOF Print] menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
[No] : Cancel the printing
[Yes] : Directly print the file with the DPOF information

※ Depending on the manufacturer and printer model, some
menus may not be available. With a printer without supporting the DPOF, the menu is still
displayed but not available.

■ DPOF Print : This allows you to directly print the files with DPOF information.

Now Printing

Print

Move:��

Standard
Index

DPOF Print

Move:��

No
Yes
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PictBridge : RESET

1. Use the LEFT and RIGHT buttons to select the [Reset]
menu tab.

2. Use the UP and DOWN buttons to select the desired
submenu value, and then press the OK button.
If [No] is selected : Settings will not be reset.
If [Yes] is selected : All print and image settings will be

reset.

※ Default print setting varies depending on the printer manufacturer.
For your printer’s default setting, refer to the user’s guide that came with your printer.

■ Initialises user-changed configurations.

Reset

Move:��

No
Yes
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Setup menu

Icon Main menu Sub menu Secondary menu Page

Series -

Reset -

Power Save 1, 3, 5, 10 min - p.96

ENGLISH P”CCK»…

한국어 PORTUGUÊS

FRANÇAIS DUTCH

DEUTSCH DANSK

Language ESPAÑOL SVENSKA p.97

ITALIANO SUOMI

BAHASA

日本語

No -

Yes -

05/01/01 13:00 -

yy/mm/dd -

dd/mm/yy -

mm/dd/yy -

Off -

Imprint Date - p.98

Date&Time -

Off -

Low  -

Medium -

High -

Computer -

Printer -

File

Format

Sound

Date&Time 

p.95

p.97

p.99

p.98

USB p.99

■ In this mode, you can set up basic settings. You can use the setup menu in all camera
modes, except Voice Recording mode.         
The items indicated by                   are default settings.
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Setup menu

※ Menus are subject to change without prior notice.

Icon Main menu Sub menu Secondary menu Page

Off -

On -

Dark -

LCD Normal - p.100

Bright -

NTSC -

PAL -

Quick View Off, 0.5, 1, 3 sec - p.103

No -

Yes -

Video Out

AF Lamp

Reset

p.100

p.101

p.103

■ This function allows the user to select the file naming format.

● Assigning File Names
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [File] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Series] : New files are named using numbers that follow the previous sequence, even

when a new memory card is used, or after formatting, or after deleting all
pictures. 

[Reset] : After using the reset function, the next file name will be set from 0001 even after
formatting, deleting all or inserting a new memory card.

5. Press the menu button twice and the menu will disappear.

File name

File
Power Save
Language
Format
Date&Time

Series
Reset

Setup

Back:◀ Set:OK
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File name

● The first stored folder name is 100SSCAM, and the first file name is SSL10001.
● File names are assigned sequentially from SSL10001 → SSL10002 → ~ → SSL10099.
● The folder number is assigned sequentially from 100 to 999 as follows: 

100SSCAM → 101SSCAM → ~ → 999SSCAM.
● The files used with the memory card conform to the DCF(Design rule for Camera File

systems) format.

INFORMATION

● Even if the battery and AC charger are removed and inserted again, the power off setting
will be preserved.

● Note that the automatic power off function will not operate if the camera is in PC mode,
slide show, playing back a voice recording, playing back a movie clip and the [Composite]
shooting.

INFORMATION

Auto power off

● Setting Power Off
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Power Save] menu by pressing the UP/

DOWN button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[1, 3, 5, 10min] : The power will turn off automatically if not used for the period of time

specified.
5. Press the menu button twice and the menu will disappear.

■ This function switches the camera off after a set amount of time in order to prevent
unnecessary battery drainage.

File
Power Save
Language
Format
Date&Time

1 min
3 min
5 min
10 min

Setup

Back:◀ Set:OK
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Language 

● Setting Language
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup] menu tab.
3. Select the [Language] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button. 
LANGUAGE sub menu : English, Korean, French, German,
Spanish, Italian, S.Chinese, T.Chinese, Japanese, Russian, Portuguese, Dutch, Danish,
Swedish, Finnish, Thai, BAHASA(MALAY/ INDONESIAN) and Arabic.

5. Press the menu button twice and the menu will disappear.

● Formatting a Memory Card
1. In any mode other than Voice Recording mode, press the

MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Format] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [No] is selected : The memory card will not be formatted. 

Press the menu button twice and the menu display will disappear. 
If [Yes] is selected : A [Please Wait!] message appears and the memory card will be

formatted. If you ran FORMAT in Play mode, a [No Image!] message
will appear.

■ There is a choice of languages that can be displayed on the LCD monitor. Even if the battery
and AC charger are removed and inserted again, the language setting will be preserved.

Formatting a memory card

■ This is used for formatting the memory card. If you run [Format] on the memory card, all
images, including the protected images, will be deleted. Be sure to download important
images to your PC before formatting the memory card.

● Be sure to run [Format] on the following types of memory card.
- A new memory card, or an unformatted memory card.
- A memory card that has a file this camera can’t recognise or one that has been taken
from another camera.

● Always format the memory card using this camera. If you insert a memory card that has
been formatted using other cameras, memory card readers, or PCs, you will get a 
[Card Error!] message.

INFORMATION

File
Power Save
Language
Format
Date&Time

ENGLISH
한국어
FRANÇAIS
DEUTSCH
ESPAÑOL

Setup

Back:◀ Set:OK

File
Power Save
Language
Format
Date&Time

No
Yes

Setup

Back:◀ Set:OK
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Setting up the Date/ Time/ Date type
■ You can change the date and time that will be displayed on the captured images and set up

the date type.

● Setting Date/Time & Selecting Date Format
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Date&Time] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP, DOWN, LEFT, and RIGHT buttons to select

the desired submenu value, and then press the OK button.
RIGHT button : Selects the year/month / day/hour / minute date type.
LEFT button : Moves the cursor to the [Date&Time] main menu if the cursor is

at the first item of the date and time setup. In all other cases, the
cursor will be shifted to the left of its current position.

UP and DOWN buttons : Changes the setting value.
- Date type : [yy/mm/dd] / [dd/mm/yy] / [mm/dd/yy] 

5. Press the menu button twice and the menu will disappear.

■ There is an option to include DATE/TIME on still images.

● Date Imprinting
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Imprint] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP and DOWN buttons to select the desired date

imprint type, and then press the OK button.
[Off] : The DATE & TIME will not be imprinted on the image file.
[Date] : Only the DATE will be imprinted on the image file.
[Date&Time] : The DATE & TIME will be imprinted on the image file.

5. Press the menu button twice and the menu will disappear.
※ The Date & Time are imprinted at the bottom right side of the still image.
※ The date will be imprinted as a DATE TYPE setting.
※ TIME is imprinted in the following way : [Hour : Minute] and hours are shown using the 24 hour clock.
※ The imprint function is applied only to still images except for the images taken in the [Text]

scene mode. 

Imprinting the recording date

File
Power Save
Language
Format
Date&Time

▲

05/ 05/ 01 13:01
▼

yy/mm/dd

Setup

Back:◀ Set:OK

Power Save
Language
Format
Date&Time
Imprint

Off
Date
Date&Time

Setup

Back:◀ Set:OK
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Sound 

Connecting an External Device (USB)

■ If you set the operation sound to ON, various sounds will be activated for camera startup,
when button are pressed, and if there is a card error, so that you can be aware of the camera
operation status.

● Setting Operation Sounds
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Sound] sub menu : Off/ Low/ Medium/ High

5. Press the menu button twice and the menu will disappear.

■ You can select an external device to which you want to connect the camera using the USB
cable.

● Selecting an External Device
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [USB] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Computer] : Select this if you want to connect the camera to your PC. 

Refer to page 127 for instructions on how to connect the camera to your PC.
[Printer] : Select this if you want to connect the camera to your printer. 

Refer to page 89 for instructions on how to connect the camera to your
printer.

5. Press the menu button twice and the menu will disappear.

Language
Format
Date&Time
Imprint
Sound

Off
Low
Medium
High

Setup

Back:◀ Set:OK

Format
Date&Time
Imprint
Sound
USB

Computer
Printer

Setup

Back:◀ Set:OK
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Auto Focus lamp

LCD brightness

● Adjusting LCD Brightness
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [LCD] menu by pressing the UP/ DOWN button

and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[LCD] sub menu : Dark, Normal, Bright

5. Press the menu button twice and the menu will disappear.

■ You can adjust the LCD brightness.

● How to set up the lamp
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [AF Lamp] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [Off] is selected : The AF lamp will not light up.
If [On] is selected : The AF lamp will light up.

※ If you select [Off] menu and take an image in poorly lit conditions or select the [Night]
scene mode, the camera may not take exact focus.

※ The Auto Focus lamp will function while using the self-timer even if the configuration is set
to off the lamp. 

■ You can turn on and off the Auto Focus lamp

Date&Time
Imprint
Sound
USB
AF Lamp

Off
On

Setup

Back:◀ Set:OK

Imprint
Sound
USB
AF Lamp
LCD

Dark
Normal
Bright

Setup

Back:◀ Set:OK
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Selecting Video out type
■ The Movie output signal from the camera can be NTSC or PAL.

Your choice of output will be governed by the type of device (monitor or TV, etc.) to which the
camera is connected. PAL mode can support only BDGHI.

● Setting the Video Out Type
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Video Out] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
- [Video Out] sub menu : NTSC, PAL

5. Press the menu button twice and the menu will disappear.

■ Connecting to an external monitor

● Using the AV cable with Cradle : Connect the camera and the cradle. 
Connect the cradle to an external monitor with the
supplied AV cable.

● Using the AV cable with Camera : Connect the camera to an external monitor with the
supplied AV cable.

Yellow - Video
White - sound

[Using the AV cable with Cradle]

[Using the AV cable with Camera]

Sound
USB
AF Lamp
LCD
Video Out

NTSC
PAL

Setup

Back:◀ Set:OK
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Selecting Video out type

● NTSC : U.S.A, Canada, Japan, South Korea, Taiwan, Mexico.
● PAL : Australia, Austria, Belgium, China, Denmark, Finland, Germany, U.K., Holland,

Italy, Kuwait, Malaysia, New Zealand, Singapore, Spain, Sweden, Switzerland,
Thailand, Norway.

● When using a TV as an external monitor, you will need to select the external or AV
channel of the TV.

● There will be a digital noise on the external monitor, but it is not a malfunction.
● If the image is not in the centre of the screen, use the TV controls to centre it.
● When the camera is connected to an external monitor, the menu will be visible on the

external monitor and the menu functions are the same as those indicated on the LCD
monitor.

INFORMATION
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Quick view
■ If you enable Quick View before capturing an image, you can view the image you just

captured on the LCD monitor for the duration set in the [Quick View] setup. Quick view is
possible only with still images.

● Setting Quick View
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Quick View] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
[Off] : The quick view function can’t be activated.
[0.5, 1, 3sec] : The captured image is briefly displayed during the selected time.

5. Press the menu button twice and the menu will disappear.

Initialisation

■ All camera menu and function settings will be restored to their default values. 
However, values for DATE/TIME, LANGUAGE, and VIDEO OUT will not be changed.

● Initialising the Camera
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [Reset] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
If [No] is selected : Settings will not be restored to their defaults.
If [Yes] is selected : All settings will be restored to their defaults.

USB
AF Lamp
LCD
Video Out
Quick Viwe

Off
0.5 sec
1 sec
3 sec

Setup

Back:◀ Set:OK

AF Lamp
LCD
Video Out
Quick Viwe
Reset

No
Yes

Setup

Back:◀ Set:OK
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Setting up the Mycam menu
■ You can set up a start up image, start up sound and shutter sound. Every camera working

mode (with the exception of Voice recording mode) has the MyCAM menu.
The items indicated by                        are default settings.

Icon Main menu Sub menu Page

Off LOGO

User Image 1 User Image 2

Off Sound 1

Sound 2 Sound 3

Off Sound 1

Sound 2 Sound 3

S.Image

S.Sound

SH.Sound

p.104

p.105

p.105

■ You can select the image that is first displayed on the LCD monitor whenever the camera is
turned on.

● Setting a Startup Image
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [S.Image] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

Start up image

● Use a saved image for the start-up image with the [User Image] in the [Resize] menu in
the play mode.

● The start-up image will not be deleted by deleting all images or [Format] menu.
● The User images will be deleted by [Reset] menu.

INFORMATION

※ Menus are subject to change without prior notice.

S.Image
S.Sound
SH.Sound

Mycam

Back:◀ Set:OK
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Start up sound

Shutter sound

● Setting the Startup Sound
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [S.Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

■ You can select the sound that is activated whenever the camera is turned on.

● Selecting the Shutter Sound
1. In any mode with the exception of Voice Recording mode,

press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Mycam]

menu tab.
3. Select the [SH.Sound] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Select a desired sub menu by pressing the UP/ DOWN

button and press the OK button.
5. Press the menu button twice and the menu will disappear.

■ You can select the shutter sound.

S.Image
S.Sound
SH.Sound

Off
Sound1
Sound2
Sound3

Mycam

Back:◀ Set:OK

S.Image
S.Sound
SH.Sound

Off
Sound1
Sound2
Sound3

Mycam

Back:◀ Set:OK
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Important notes
Be sure to observe the following precautions!

■ This unit contains precision electronic components. Do not use or store this unit in the
following locations.

- Areas exposed to severe changes in temperature and humidity.
- Areas exposed to dust and dirt.
- Areas exposed to direct sunlight or the inside of a vehicle in hot weather.
- Environments where there is high magnetism or excessive vibration.
- Areas with high explosives or highly flammable materials.

■ Do not leave this camera in places subject to dust, chemicals (like naphthalene and
mothball), high temperature and high humidity.
Keep this camera with silica gel in a hermetically sealed box when not planning to use the
camera for a long period of time

■ Sand can be particularly troublesome to cameras.

- Do not let sand get inside the unit when using it on beaches, coastal dunes, or other areas
where there is lots of sand.

- Doing so may result in failure or may permanently render the unit unusable.

■ Handling the camera

- Never drop the camera or subject it to severe shocks or vibrations.
- Prevent the large size LCD monitor from an impact. When this camera is not used, keep
this camera in the camera case.  

- Avoid obstructing the lens or the flash when you capture an image.
- This camera is not waterproof.
To avoid dangerous electrical shocks, never hold or operate the camera with wet hands.

- If you use this camera in wet places, such as beach or pool, do not let water or sand get
inside the camera. Doing so may result in failure or may permanently damage the unit.

■ Extremes in temperature may cause problems.

- If the camera is transferred from a cold to a warm and humid environment, condensation
can form on the delicate electronic circuitry. If this occurs, turn the camera off and wait for at
least 1 hour until all moisture is dispersed. Moisture build up can also occur in the memory
card. If this happens, turn off the camera and remove the memory card. Wait until the
moisture has dispersed.
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Important notes
■ Caution on Using the Lens

- If the lens is subjected to direct sunlight, it could result in discoloration and deterioration of
the image sensor.

- Pay attention not to get fingerprints or foreign substances on the surface of the lens.

■ If the digital camera is not used for a long period, an electric discharge can occur. 
It is a good idea to remove the batteries and the memory card if you do not intend using the
camera for an extended period of time.

■ If the camera is exposed to an electronic interference, it will turn itself off to protect the
memory card.

■ Camera Maintenance

- Use a soft brush (available from photo stores) to gently clean the lens and LCD assemblies.
If this does not work, lens-cleaning paper with lens cleaning fluid can be used.
Clean the camera body with a soft cloth. Do not allow this camera to come into contact with
solvent materials such as benzol, insecticide, thinners etc. This may damage the body shell
of the camera and also affect its performance. Rough handling can damage the LCD
monitor. Take care to avoid damage and keep the camera in its protective carry case at all
times when not in use.

■ Do not attempt to disassemble or modify the camera.

■ Under certain conditions, static electricity can cause the flash unit to fire. This is not harmful to
the camera and is not a malfunction.

■ When images are uploaded or downloaded(when the charger and USB cable are inserted
into the cradle at the same time), the data transfer may be affected by static electricity. 
In this case, disconnect and re-connect the USB cable before trying the transfer again.

■ Before an important event or going on a trip, you should check the camera condition. 

- Take a picture for testing the camera condition and prepare extra batteries.
- Samsung cannot be held responsible for camera malfunctions. 
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Warning indicator
■ There are several warnings that may appear on the LCD display

Card Error!

ㆍMemory card error
→ Turn off the camera power and turn it on again
→ Insert the memory card again
→ Insert the memory card and format the memory card (p.97)

Memory Error!

ㆍInternal memory error
→ Turn off the camera power and turn it on again
→ Format the memory with the memory card removed. (p.97)

No Card!

ㆍA memory card is not inserted
→ Insert a memory card

ㆍThe camera can’t recognise the memory card
→ Insert the memory card again
→ Turn off the camera power and turn it on again

Card Locked!

ㆍThe memory card is locked
→ SD memory card : Slide the write protect switch to the top of the memory card

Card Full !/ Memory Full!

ㆍThere is insufficient memory capacity to take an image
→ Insert a new memory card
→ Delete unnecessary image files to free up some memory

No Image!

ㆍThere are no images stored on the memory card
→ Take images
→ Insert a memory card that is holding some images

File Error!

ㆍFile error
→ Format the memory card

ㆍMemory card error
→ Contact a camera service centre

Low Battery!

ㆍThere is low battery capacity
→ Insert charged battery
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Warning indicator
Low Light!

ㆍWhen taking pictures in dark places
→ Take pictures in Flash Photography mode.

Set USB

ㆍ[USB] sub menu and connected device are not matched.
→ Reconfigure [USB] in the [Setup] menu. 

Out Of Number

ㆍWhen selecting too many printing pages in the PictBridge menu. 
→ Select printing page within the limitation. 

■ Please check the following

Before contacting a service centre

The camera doesn’t switch on

ㆍThere is low battery capacity
→ Insert charged battery (p.14 ~ 18)

ㆍBatteries are inserted incorrectly with the reverse polarities
→ Insert the batteries according to the polarity marks (+, -)

ㆍThe rechargeable battery is not inserted
→ Insert the battery and turn on the camera

The camera power ceases while in use

ㆍThe batteries are exhausted
→ Insert charged battery

ㆍThe Camera is turned off automatically
→ Turn on the camera power again. 

Batteries drain quickly

ㆍThe Camera is being used in low temperatures
→ Keep the camera in warm conditions (i.e. inside a coat or jacket) and only remove it in

order to take images
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Before contacting a service centre
Camera does not take images when pressing the Shutter button

ㆍThere is insufficient memory capacity
→ Delete unnecessary image files

ㆍThe memory card has not been formatted
→ Format the memory card (p.97)

ㆍThe memory card is exhausted
→ Insert a new memory card

ㆍThe memory card is locked
→ Refer to [Card Locked!] error message (p.108)

ㆍThe camera’s power is off
→ Turn the camera power on

ㆍThe batteries are exhausted
→ Insert charged battery (p.14 ~ 18).

ㆍBatteries are inserted incorrectly with the reverse polarities
→ Insert the batteries according to the polarity marks (+, -)

The camera suddenly stops working while in use 

ㆍThe camera was stopped due to a malfunction
→ Remove /re-insert batteries and switch the camera on

The images are unclear

ㆍA picture was taken within 0.5m from the subject without setting an appropriate macro mode
→ If the subject is closer than 0.5m, select macro shot mode

ㆍTaking a picture beyond the flash range
→ Take a picture within the flash range

ㆍThe lens is smudged or dirty
→ Clean the lens

The flash does not fire

ㆍFlash off mode has been selected
→ Dis-engage flash off mode

ㆍThe camera mode can’t use the flash
→ Refer to the FLASH instruction (p.37)

Incorrect date and time is displayed

ㆍThe date and time have been set incorrectly or the camera has adopted the default settings
→ Reset the date and time correctly
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Before contacting a service centre
The camera buttons do not operate

ㆍCamera malfunction
→ Remove /re-insert batteries and switch the camera on

A card error has occurred while the memory card is in the camera.

ㆍIncorrect memory card format
→ Re-format the memory card 

The images don't play back

ㆍIncorrect file name (Violation of DCF format)
→ Do not change the image file name

Colour of image is different to the original scene 

ㆍWhite balance setting is incorrect
→ Select appropriate White balance

Images are too bright

ㆍExposure is excessive
→ Reset exposure compensation

No image on external monitor

ㆍThe external monitor has not been connected properly with the camera
→ Check the connection cables

ㆍThere are incorrect files in the memory card
→ Insert a memory card that has correct files

When using the PC’s explorer, the [Removable Disk] file does not show

ㆍCable connection is incorrect
→ Check the connection

ㆍThe camera is off
→ Turn the camera on

ㆍThe operating system is not Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3.
Alternatively the PC does not support USB
→ Install Windows 98, 98SE, 2000, ME, XP/ Mac OS 9.2 ~ 10.3 to PC that supports USB

ㆍThe camera driver is not installed
→ Install a [USB Storage Driver]
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Specifications
Type 1/2.5" CCD
Effective Pixel Approx. 5.0 Mega-pixel
Total Pixel Approx. 5.1 Mega-pixel

SHD Lens f = 6.6 ~ 19.8mm  
(35mm film equivalent : 39 ~ 117mm)

Lens F No. F 3.5 ~ F 4.5
Still Image mode : 1.0X ~ 5.0X  
Play mode : 1.0X ~ 10.1X (depends on image size)

LCD Monitor 2.5" color TFT LCD (230,000 pixels)
Type TTL auto focus

Normal : 50cm ~ infinity
Macro : 5cm ~ 50cm (Wide), 25cm ~ 50cm (Tele)
Super Macro : 1cm ~ 5cm (Wide)
Auto : 5cm ~ Infinity (Wide), 50cm ~ Infinity (Tele)

Type Mechanical and Electronic shutter
Speed 1 ~ 1/2,000 sec. (Night : 16 ~ 1/2,000 sec.)
Control Program AE  Metering : Multi, Spot
Compensation ±2EV (0.5EV steps)
ISO Equivalent Auto, 100, 200, 400

Auto, Auto & Red-eye reduction, Fill-in flash, Slow sync, 
Flash off

Range Wide : 0.2m ~ 2.4m,  Tele : 0.3m ~ 1.9m (ISO AUTO)
Recharging Time Approx. 5 sec.

Sharpness Soft, Normal, Vivid
Effect Normal, B&W, Sepia, Negative, Red, Green, Blue, RGB

Auto, Daylight, Cloudy, Fluorescent_H, Fluorescent_L,
Tungsten, Custom 
Voice Recording (max. 1 hour) 
Voice Memo in Still Image (max. 10 sec.)

Date Imprinting Date, Date&Time, Off (user selectable)
Modes : Auto, Manual, Scene, SF
* Scene : Night, Portrait, Children, Landscape, Text, Close-up,

Sunset, Dawn, Backlight, Fireworks, Beach & Snow
Continuous : Single, Continuous
Self-timer : 2 sec., 10 sec., Double(10 sec., 2 sec.) 
With Audio or without Audio (recording time : memory capacity dependent)
Size : 640x480, 320x240, 160x128 (3X Optical Zoom, Mute during Zoom Operation)
Frame rate : 30 fps, 15 fps
Movie Stabilizer (User Selectable)
Movie Editing (Embeded) : Pause during recording, Still Image

Capture, Time Trimming

Focal Length

Range

Digital Zoom

Focusing

Image Sensor

Shutter

Exposure

White Balance

Flash
Modes

Voice Recording

Shooting

Still Image

Movie Clip
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Specifications
Internal memory : 50MB flash memory
External memory : SD card /MMC (Up to 1GM Guaranteed)
Still Image : JPEG (DCF), EXIF 2.2, DPOF 1.1, PictBridge 1.0 
Movie Clip : AVI (MPEG-4) Audio : WAV
5M : 2592x1944     4M : 2272x1704
3M : 2048x1536     2M : 1600x1200 
1M : 1024x768    VGA : 640x480 
5M  : Super Fine 11,  Fine 21,  Normal 33 
4M  : Super Fine 14,  Fine 26,  Normal 40
3M  : Super Fine 17,  Fine 33,  Normal 50
2M  : Super Fine 30,  Fine 51,  Normal 75
1M  : Super Fine 60,  Fine 106,  Normal 129
VGA : Super Fine 121,  Fine 165,  Normal 202
* These figures are measured under Samsung’s standard

conditions and may vary depending on shooting conditions 
and camera settings.

Type Single image, Thumbnails, Slide show, Movie Clip, Album 
Editing Trimming, Resizing, Rotate, Effect

Digital output connector : USB 2.0 Audio : Mono
Video output : NTSC, PAL (user selectable)
DC power input connector : 4.2V
Rechargeable battery : 3.7V Li-ion battery (SLB-0737) 
AC Charger : DC 4.2V, 450mA/ 750mA (SAC-41)
* Included battery may vary depending on sales region. 
Approx. 89.6 x 59.8 x 17.3 mm 
(excluding the projecting parts of the camera)

Weight Approx. 132g (without batteries and card)
Operating Temperature 0 ~ 40 ˚C
Operating Humidity 5 ~ 85 %

Storage Driver (Windows98/98SE/2000/ME/XP, 
Mac OS 9.2 ~ 10.3)

Application Digimax Viewer, Digimax Reader, ArcSoft PhotoImpression 
SF(Safety Flash)
3X Optical Zoom for Still & Movie.
New Charging System (Cradle (Optional))
MPEG-4 VGA 30fps Movie Clip (supporting Edit on DSC)
Powerful Effect (Color, Highlight, Composite, Frame)
Quick Mode Change (M button, SF Button)

※ Specifications are subject to change without prior notice.
※ All trademarks are the property of their respective owners.

Capacity
(50MB memory
card)

Image Size

Storage

Interface

Image Play

Dimensions (WxHxD)

Power Source

Software

Special Features

Camera Driver

File Format

Media
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Software Notes
Please ensure that you read the instruction manual carefully before use.
ㆍThe attached software is a camera driver and image editing software tool for Windows.
ㆍUnder no circumstances should all or part of either the software or the user manual be

reproduced.
ㆍCopyrights for software are licensed only for use with a camera.
ㆍIn the unlikely event of a manufacturing fault, we will repair or exchange your camera. 

We cannot, however, be held responsible in any way for damage caused by inappropriate
use.

ㆍUsing a Hand-made PC or a PC and OS that has not been guaranteed by the manufacturer is
not covered by the Samsung warranty.

ㆍBefore reading this manual, you should have a basic knowledge of computers and O/S
(Operating Systems).

System Requirements

For Windows For Macintosh

Power Mac G3 or later

Windows 98/98SE/2000/ME/XP Mac OS 9.2 ~ 10.3

Minimum 32MB RAM (XP : 128MB) Minimum 64MB RAM

140MB of available hard-disk space 110MB of available hard-disk space

USB port USB port

CD-ROM drive CD-ROM drive

QuickTime player

DivX(for movie clip)

PC with processor better than MMX 

Pentium 233MHz (XP : Pentium II 300MHz)

800x600 pixels, 16-bit colour display

compatible monitor (24-bit color display

recommended)
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About the software
After inserting the CD-ROM provided with this camera into the CD-ROM drive, the following
window should automatically run.

Before connecting the camera to the PC,
you should first install the camera driver.

■ Camera driver : This enables images to transfer between the camera and PC.
This camera uses the USB Storage Driver as the camera driver. You can use the camera as
a USB card reader. After installing the driver and connecting this camera to the PC, you can
find [Removable Disk] in [Windows Explorer] or [My computer]. A USB Storage Driver is
provided only for Windows. A USB Driver for MAC is not included with the Application CD.
But you can use the camera with Mac OS 9.2 ~ 10.3.

■ XviD codec : This makes movie clips(MPEG-4) recorded with this camera play back on
a PC. 

To play back a movie clip recorded with this camera, you must install the XviD codec. 
If a movie clip recorded with this camera does not play well, install this codec. 
This software is only compatible with Windows. 
If a movie clip can’t play back on the Mac OS, please visit the following site.
http://www.divx.com/divx/mac/

■ Digimax Viewer : This is a program for viewing stored images.
You can see the stored images in the memory directly on a PC monitor. You can also copy,
move or delete the images and enlarge/downscale the image sizes with Digimax Viewer.
This software is only compatible with Windows.
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About the software
■ Digimax Reader : Text recognition program.

You can save an image file that was captured in the TEXT mode as a text file with this
program. This software is only compatible with Windows.

■ PhotoImpression : Image editing program.
You can edit or store still images that you download from the camera. 
This software is only compatible with Windows.

● Be sure to check the system requirements before installing the driver.
● You should allow 5 ~ 10 seconds for running the automatic setup program according to

the capability of the computer. If the frame does not show, run the [Windows Explorer]
and select [Samsung.exe] in the CD-ROM Drive root directory.

INFORMATION
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Setting up the application software
To use this camera with a PC, install the application software first.
After this has been done, the stored images in the camera can be moved to the PC and can be
edited by an image editing program.

You can visit the Samsung web-site through the internet.

http://www.samsungcamera.com : English
http://www.samsungcamera.co.kr : Korean

1. Click the [Install] menu in the Autorun frame.
The camera driver is installed automatically.

● Close other programs before installing the application software.
● Before installing the application software, disconnect the USB connection.

INFORMATION

2. Installation is complete.
Click the [Finish] button.

[Click !]

[Click !]

3. A windows to check whether the PC has XviD codec or
not will display.  
[Preview] : You can check the movie clip display

condition. 
[Install] : The XviD codec is installed. 
[Cancel] : The XviD codec is not installed and a

window for installing the application
softwares will display.

※ If you didn’t click the [Preview] button, the [Install] button can’t be selected. 

[Click !]
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Setting up the application software

6. The Software License Agreement window will be
displayed. If you agree to this, select [I accept the
agreement] and click [Next >] button. The window will
then move to the next step. If you disagree, select 
[I do not accept the agreement] and click [Cancel]
button. 
The installation program will be cancelled.

※ The XviD codec is distributed according to the GNU
General Public License and everyone can copy,
distribute and change this codec. For more information,
see the License documents. 

[Click !]

4. If an error listed below takes place during the preview,
click the [Install] button to install the XviD codec. 

- Only a voice plays back. 
- An error message displays and the movie clip does not
play back.

* A window shown alongside may display according to
the system requirements.

5. The XviD codec installation window will be displayed
as shown alongside. Click the [Next >] button. 

[Click !]

[Click !]
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Setting up the application software
7. The XviD information window will display. 

Click the [Next >] button. 

8. The destination selection window will open. 
Click [Next >] button.
To copy to the files to another folder, click [Browse...]
and choose a folder you want.

[Click !]

[Click !]

10. The [Select Additional Tasks] window will display. 
Select the additional tasks and click the [Next >] button. 

9. A window will open, asking you to choose a folder to
which program icons will be added. 
Click [Next >] button. 
If you want to add the program icons to a different folder,
choose another folder, and then click [Next >] button.

[Click !]

[Click !]
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Setting up the application software
11. The XviD codec is ready to install. 

Click the [Install] button.

[Click !]

12. Installation is complete.
Click the [Finish] button.

[Click !]

● If you select [Exit] at step 13, the application program installation will be cancelled.

INFORMATION 

13. A window where you can choose the program
you want to install will appear. Click [Install]. 
For information on application software, please
refer to page 115, 116.

14. The [Digimax Viewer 2.1] installation window
will be displayed as shown alongside. 
Click the [Next >] button.

[Click !]

[Click !]
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Setting up the application software

● If you select [Cancel] at step 14, a window for installing Digimax Reader will be displayed.

INFORMATION

15. The Software License Agreement window will be
displayed. 
If you agree to this, click [Yes], the window will then
move to the next step. 
If you disagree, click [No] and the installation program
will be canceled.

[Click !]

18. Digimax Viewer installation is successfully completed.
Click the [Finish] button to install Digimax Reader. 
* The system will not reboot even the [Yes, I want to

restart the computer now] option is selected.
* The real frame 18 can be different with the

illustration according to the system requirements.

17. A window will open, asking you to choose a folder to
which program icons will be added. 
Click [Next >] button.

[Click !]

[Click !]

16. A destination selection window will open. 
Click [Next >]. 
To copy to the files to another folder, click [Browse..]
and choose a folder you want.

[Click !]
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Setting up the application software
19. A window will be displayed as shown alongside.

Click the [INSTALL] button.

- Check the [MANUAL] button. Instructions for using
Digimax reader will be displayed.

- Click the [EXIT] button and Digimax reader installation
will be cancelled and a window for installing
PhotoImpression will be displayed. 

20. A window will open.
Click the [Next >] button.

[Click !]

[Click !]

22. A destination selection window will open. 
Click [Next >].
To copy to the files to another folder, click [Browse...]
and choose a folder you want.

21. The Software License Agreement window will be
displayed. If you agree to this, click [Yes], the window
will then move to the next step. If you disagree, click
[No] and the installation program will be cancelled.

[Click !]

[Click !]
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Setting up the application software

26. The Software License Agreement window will be
displayed. 
If you agree to this, click [Yes], the window will then
move to the next step. 
If you disagree, click [No] and the installation
program will be canceled.

25. A Welcome window will be displayed.
Click the [Next >] button.

[Click !]

[Click !]

24. The PhotoImpression installation window will be
displayed as shown alongside.
Click the [OK] button.

[Click !]

23. Digimax Reader Installation is completed.
Click the [Finish] button and PhotoImpression
installation will be started. The system will not reboot
even if the [Yes, I want to restart the computer now]
option is selected. 

*The real frame 23 can be different with the illustration
according to the system requirements.

[Click !]
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Setting up the application software
27. A destination selection window will open.

Click [Next >]. To copy to the files to another folder,
click [Browse...] and choose a folder you want.

28. The [Select Components] window will appear. 
Click [Next >] button.

29. A window will open, asking you to choose a folder to
which program icons will be added.
Click [Next >] button. If you want to add the program
icons to a different folder, choose another folder, and
then click [Next >] button.

[Click !]

[Click !]

[Click !]

30. PhotoImpression Installation is completed.
Click the [Finish] button.
* The system will not reboot even if the [Yes, I want to

restart the computer now] option is selected. 
* The real frame 30 can be different with the illustration

according to the system requirements.

[Click !]
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Setting up the application software
31. To apply changes, you must restart the computer.

Select [Yes, I want to restart my computer now], and
then click [Finish]. 

[Click !]

33. Turn the camera power on.
[Found New Hardware Wizard] will open and the
computer will recognise the camera.

* If you have ever installed an image viewer program
or your OS is Windows XP, an image viewer
program will open.
If the image viewer program opens, the camera
driver was setup successfully.

32. After restarting the computer, connect the PC to the camera with the USB cable. 

34. If you can see [Removable Disk] under 
[My computer], the camera driver installation was
successful.
Now you can transfer image files from the camera to
PC via the USB cable.
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Setting up the application software

● If you have installed the camera driver, [Found New Hardware Wizard] may not open.
● On a Windows 98 or 98 SE system, the Found New Hardware Wizard dialog box opens

and a window asking you to select a driver file may appear. In this case, specify "USB
Driver" in the CD supplied. (for Windows 98 and 98 SE).

● Before connecting the camera to the PC, You should first install the camera driver.
● After installing the camera driver, you have to restart your PC.
● If you connect the camera to the PC before installing the camera driver, the [Found New

Hardware Wizard] will open.
In this case, cancel the [Found New Hardware Wizard] and disconnect the camera. Install
the camera driver and connect the camera to the PC again.

● Should the computer not find the camera driver after installation, please try one or more of
the following measures.
1. Delete the camera driver (p.130), and re-install the driver.
2. Refer to FAQ (p.139) to check for a possible solution to the problem.
3. If your PC’s central processing unit is VIA chip (This is shown in the USB Host

Controller), download the patch file from the Samsung Camera web page.
(http://www.samsungcamera.com)

INFORMATION
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Starting PC mode

■ Connecting the camera to a PC
1. In any mode with the exception of Voice Recording

mode, press the MENU button.
2. Press the LEFT/ RIGHT button and select the [Setup]

menu tab.
3. Select the [USB] menu by pressing the UP/ DOWN

button and press the RIGHT button.
4. Use the UP and DOWN buttons to select [Computer],

and then press the OK button.

[Using the USB cable with Cradle]

[Using the USB cable with Camera]

※ If you selected [Printer] in Step 4, when you connect the camera to your printer, the
[Connecting Printer] message will display and the connection will not be established.
In this case, disconnect the USB cable, and then follow the procedure from Step 2 and
onward.

• If you connect the USB cable to a USB port on your PC and then turn on the power, the
camera will automatically switch to "computer connection mode".

• In this mode, you can download stored images to your PC through the USB cable.

Format
Date&Time
Imprint
Sound
USB

Computer
Printer

Setup

Back:◀ Set:OK



《128》

Starting PC mode

3. Select an image and press the right mouse button.

4. A pop-up menu will open.
Click [Cut] or [Copy] menu.
- [Cut] : cuts a selected file.
- [Copy] : copies files.

■ Downloading stored images

You can download the still images stored on the camera to your PC's hard disk and print
them or use a photo editing software to edit them.

1. Connect the camera to your PC with the USB cable.

2. On your computer's desktop display, select
[My computer] and double click [Removable Disk →
DCIM → 100SSCAM].
The image files will then be displayed.

5. Click a folder where you want to paste the file.
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Starting PC mode

7. An image file is transferred from the camera to your
PC.

6. Press the right mouse button and a pop-up menu
will open. Click [Paste].

- By using [Digimax Viewer], you can see the stored images in the memory directly on the PC
monitor and you can copy or move the image files.
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Removing the USB Driver for Windows 98SE
■ To remove the USB driver, refer to the process shown below.

1. Trace [Start → Settings] and click [Control Panel].

[Click !]

4. Uninstallation is complete. 
Click the [Finish] button and the window will
disappear.

2. Double-click [Add/Remove programs].

3. The [Add/Remove Programs Properties] window
will open. Click [Digimax i5] and click the
[Add/Remove] button.

[Click !]
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Removable Disk
■ To use this camera as a Removable Disk, install (p.117) the USB Driver.

1. Before turning the camera power on, connect the camera to the PC with the USB cable.

2. Click [Removable Disk] under [My computer] or [Windows Explorer].

3. Image files stored in the Removable Disk (DCIM → 100SSCAM) can be transferred to the
PC.

Important information whilst using the Removable Disk
● The [Removable Disk] indicator will not show when the camera power is off or the USB

cable is removed.
● We recommend that you should copy the images to the PC to view them. Opening

images directly from the removable disk may be subject to unexpected disconnection.
● When uploading images from the PC to the camera, ensure that the uploaded file names

are not the same as those already stored on the memory. 
● When you upload a file that is not taken by this camera to Removable Disk, the [File

Error!] message will be displayed on the LCD monitor in the PLAY mode, and nothing is
displayed in THUMBNAIL mode.

● The camera status lamp will blink, when a file is
transferred (copy or deletion) between the PC and
the camera. Do not remove the USB cable until
the lamp stops blinking. 
To remove the USB cable in Windows
2000/ME/XP, use the [Unplug or Eject Hardware]
icon on the task bar.

INFORMATION

100-0009
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Removing the removable disk

[Click !]

[Double-click!]

[Click !]

[Click !]

2. Double-click the [Unplug or Eject Hardware] icon
on the task bar.

■ Windows 2000/ME/XP
(The illustrations may be different from the real display in accordance with the Windows O/S.)

1. Check whether the camera and PC are transferring a file. 
If the camera status lamp blinks, you have to wait until the lamp illuminates.

■ Windows 98SE

1. Check whether the camera and PC are transferring a file. 
If the camera status lamp blinks, you have to wait until the lamp illuminates.

2. Unplug the USB cable.

3. The [Unplug or Eject Hardware] window will
open. Select the [USB Mass Storage Device]
and click the [Stop] button.

4. The [Stop a Hardware device] window will open.
Select the [USB Mass Storage Device] and click
the [OK] button.

5. A [Safe to Remove Hardware] window will
open. Click the [OK] button.
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Removing the removable disk

1. A USB Driver for MAC is not included with the software CD as MAC OS supports the
camera driver.

2. Check the MAC OS. You can check the MAC OS version during MAC OS start-up. 
This camera is compatible with MAC OS 9.2 ~ 10.3.

3. Connect the camera to the Macintosh and turn the camera power on.
4. A new icon will be displayed on the desktop after connecting the camera to the MAC.

Using the USB Driver for MAC

Setting up the USB Driver for MAC

1. Double click a new icon on the desktop and the folder in the memory will be displayed.
2. Select an image file and copy or move it to MAC.

● For Mac OS 10.0 or later : First complete uploading from computer to camera and then
remove the removable disk with the Extract command.

● If a movie clip can’t play back on the Mac OS, please visit the following site.
http://www.divx.com/divx/mac/

CAUTION

6. A [Unplug or Eject Hardware] window will open.
Click the [Close] button and the removable disk
will be removed safely.

7. Unplug the USB cable.

[Click !]
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Digimax Viewer 2.1

● Before deleting images from the camera, you should download images to your computer
that you wish to keep.

● Refer to the [Help] menu in Digimax viewer 2.1 for further information.

INFORMATION 

■ This software is only compatible with Windows.

1. To open Digimax Viewer, click the [Start →
Programs → Samsung → Digimax Viewer 2.1 →
Digimax Viewer 2.1 ] and Digimax Viewer 2.1 will
then open. 

3. You can easily use the Digimax viewer 2.1 program
as it offers a FILE menu and TOOL bar. And, you
can use the pop up menu. Click an image and press
the right mouse button.

Digimax Viewer functions are listed below.
- Basic functions : Copy, Move, Delete, Rotate, Rename, changing file type, Resize,

Property.
- Advanced functions : Print, Slide show, Export, Sending e-mail, On-line print, Web

album etc.

2. If the [Auto Launch] option is selected, this program will be executed automatically with
recognizing the camera.
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Digimax Reader
■ Digimax Reader is a Text recognition program. You can save an image file that is captured in

the Text mode, as a text file with this program. 
This software is only compatible with Windows.

■ To start the program, click [Start → Programs → Digimax Reader Eng]. 
The following screen will appear.

■ How to use the Digimax Reader
1. Connect the camera and the PC with a USB cable and download the images that were

stored in the camera to the PC.  
* Please see page 127 ~ 129 for details on Connecting a camera and PC, Downloading

images. 

2. Run the Digimax Reader.

3. Click the Open(          ) icon as shown alongside. 
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Digimax Reader
4. Select the image you want to save as a text file. 

* Only an image that was taken with SAMSUNG
camera can be opened. 

5. Click the Area Analysis(         ) icon to scan the
image. 

6. Part of the image you selected will be displayed as
shown. 

7. Click the Character  Recognition(         ) icon. 
The part selected in the previous step will be
recognized as text. 

8. To save the section as a text, click the Save(         )
icon. A window as shown alongside will be
displayed. 
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Digimax Reader

ㆍWith PhotoImpression, you can edit or store still images that you downloaded from the
camera. This software is only available in Windows version.

ㆍTo start the program, click [Start → Programs → ArcSoft PhotoImpression 4 →
PhotoImpression 4]. The following screen will appear.

[ Command Button ]

[ Tool Bar ]

[ Help Button ]

● To get an image that can be recognized as a text : 
- Keep a distance of 20cm between the subject and the camera. 
- The subject need to be centered. 
- Avoid the camera shake to get a good image. 

● Refer to the [Help] menu in Digimax Reader for further information.

INFORMATION 

9. Select a file type that you want to.  
Selectable file type : *.TXT, *.HWP, *.DOC, *.RTF

Using PhotoImpression
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Using PhotoImpression
ㆍYou can use PhotoImpression to perform the following tasks.

■ Command Button

Button  Description

Imports a picture from an album, a source folder, or the camera/scanner, 
or captures screen shots of what is being viewed on the current monitor.

Selects Cut, Resize, Edit Image, Insert Text, Enhance Picture, Insert Effects, 
or Layer.

Performs Insert Frame, Insert Borders, Insert Calendar, Insert Greeting Cards,
Insert Template, or Connect with Other Software.

Saves the edited picture, and sends an e-mail or uses it as the background
image.

Outputs the edited picture according to your preferences.

■ Tool Bar

Button Description Button Description

Resize Layer

Flip Layer Horizontally

Undo

Copy

Delete Layer

Rotate Layer

Rotate All Layers

Redo

Paste

Close Picture

● For detailed instructions on how to use PhotoImpression, please refer to the program's
Help.

INFORMATION
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FAQ
■ Please check the following if the USB connection malfunctions.

[Case 1] The camera power is off.
→ Turn the camera power on.

[Case 2] USB Driver is not installed correctly.
→ Install the USB Driver correctly. Refer to page 117.

[Case 3] The USB cable is not connected or you are using a cable with an incorrect
specification.

→ Use a USB cable with the correct specification.

[Case 4] The camera is not recognized by your PC. 
Sometimes, the camera may appear under [Unknown Devices] in Device
Manager.

→ Install the camera driver correctly.
Turn off the camera, remove the USB cable, plug in the USB cable again, and
then turn on the camera.

[Case 5] There is an unexpected error during file transfer
→ Turn the camera power off and on again. Transfer the file again.

[Case 6] How do I know my computer supports a USB Interface?
→ Check the USB port in your computer or keyboard.
→ Check the OS version. A USB Interface is available in Windows 98, 98SE, 2000,

ME .XP.
→ Check [Universal Serial Bus controllers] in Device Manager. Do the following to

check [Universal Serial Bus controllers].
Win 98/ME : Trace [Start → Settings → Control Panel → System →

Device Manager  → Universal Serial Bus controllers].
Win 2000 : Trace [Start → Settings → Control Panel → System →

Hardware → Device Manager → Universal Serial Bus
controllers].

Win XP : Trace [Start → Control Panel → Performance and Maintenance →
System → Hardware → Device Manager → Universal Serial Bus
controllers].
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FAQ
There must be USB Host Controller and USB root hub under [Universal Serial
Bus controllers].
In addition, double-click on the USB Universal Host Controller and the USB Root
Hub to check if the Device Status states "This device is working properly". 
If the Device Status says the device is "not working properly", click the "Driver" tab
and then click [Update Driver] or [Reinstall Driver].

→ When all the conditions mentioned above are met, the computer can support the
USB interface.

[Case 7] When using the USB hub.
→ There may be a problem in connecting the camera to the PC through the USB

hub if the PC and the hub are not compatible. Wherever possible, connect the
camera to the PC directly.

[Case 8] Are other USB cables connected to the PC?
→ The camera may malfunction when it is connected to the PC at the same time as

another USB cable.  In this case, disconnect the other USB cable, and connect
only one USB cable to the camera.

[Case 9] When I open the Device Manager (by clicking Start → (Settings) → Control Panel
→ (Performance and Maintenance) → System → (Hardware) → Device
Manager), there are  「Unknown Devices」or  「Other Devices」entries with a
yellow question mark(?) beside them or devices with an exclamation mark(!)
beside them.

→ Right-click on the entry with the question(?) or exclamation (!) mark and select
"Remove". Restart the PC and connect the camera the again. For Windows 98
PC, remove the camera driver also, restart the PC, and then reinstall the camera
driver.

→ Double-click on the entry with the question (?) or exclamation (!) mark, click the
"Driver" tab, and click [Update Driver] or [Reinstall Driver]. If a message appears
asking you to specify the location of the appropriate device driver, specify "USB
Driver" in the CD supplied.
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FAQ
■ When the movie clip doesn’t play back on the PC

※When the movie clip recorded by the camera doesn’t play back on the PC, the causes are
mostly codec installed on the PC. 

●When A codec for play back the movie clip isn’t installed
→ Install the codec as listed below. 

[Installing a codec for Windows]
1) Insert the CD provided with the camera 
2) Run the windows explorer and select [CD-ROM drive:\Xvid] folder and click the Xvid-

1.0.2.exe file. 

[Installing a codec for Mac OS]
1) Visit the following site for downloading the codec.http://www.divx.com/divx/mac
2) Click the [Free Download] button located upper right side of the page and a window for

downloading the DivX codec will display. 
3) Select Mac OS you use and click the [Download] button. Save it on a folder you want to. 
4) Run the downloaded file and the codec for playing back the movie clip will be installed. 

● When the DirectX 8.1 or later is not installed
→ Install the DirectX 8.1 or later
1) Insert the CD provided with the camera
2) Run the windows explorer and select [CD-ROM drive:\ USB Driver\DirectX 8.1] folder and

click the DXESETUP.exe file.The DirectX will be installed. Visit the following site for
downloading the DirectX.http://www.microsoft.com/directx
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● If a PC (Windows 98) stops responding while the camera and PC are connected repeatedly

→ If a PC (Windows 98) is turned on for a long time and connect the camera repeatedly, the
PC may not recognise the camera. In this case, re-start the PC. 

● If a PC connected with the camera stops responding while the Windows is starting. 
→ In this case, disconnect the PC and the camera and the windows will start correctly. 

If the problem happens continuously, set the Legacy USB Support to disable and re-start
the PC. The Legacy USB Support is in the BIOS setup menu. (The BIOS setup menu
differs from the PC manufacturers and some BIOS menus don’t have Legacy USB
Support) If you can’t change the menu by yourself, contact to the PC manufacturer or
BIOS manufacturer. 

● If the movie clip can’t be deleted, removable disk can’t be extracted or an error message
displays during the file transfer.  
→ If you install only the Digimax Viewer, the problems mentioned above occasionally

happen. 
- Close the Digimax Viewer program by clicking the Digimax Viewer icon on the Taskbar.
- Install all the application programs included in the software CD. 
(You must install the Movie clip codec)
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SAMSUNG TECHWIN CO., LTD.
OPTICS & DIGITAL IMAGING DIVISION

145-3, SANGDAEWON 1-DONG, JUNGWONGU,
SUNGNAM-CITY, KYUNGKI-DO, KOREA
462-121
TEL : (82) 31-740-8086,8088, 8090, 8092, 8099
FAX : (82) 31-740-8398, 8111
www.samsungcamera.com

SAMSUNG OPTO-ELECTRONICS AMERICA, INC.
HEADQUARTERS
40 SEAVIEW DRIVE, SECAUCUS, NJ07094, U.S.A.
TEL : (1) 201-902-0347
FAX : (1) 201-902-9342

WESTERN REGIONAL OFFICE
18600 BROADWICK ST.,
RANCHO DOMINGUEZ, CA 90220, U.S.A.
TEL : (1) 310-900-5263/5264
FAX : (1) 310-537-1566
www.samsungcamerausa.com

SAMSUNG OPTO-ELECTRONICS UK LIMITED
SAMSUNG HOUSE
1000 HILLSWOOD DRIVE
HILLSWOOD BUSINESS PARK
CHERTSEY KT16 OPS U.K.
TEL : 00800 12263727
(free for calls from UK only)
UK Service Hotline : 01932455320
www.samsungcamera.co.uk

SAMSUNG OPTO-ELECTRONICS GMBH
AM KRONBERGER HANG 6
D-65824 SCHWALBACH/TS., GERMANY
TEL : (49) 6196 66 53 03
FAX : (49) 6196 66 53 66
www.samsungcameras.de

SAMSUNG FRANCE S.A.S.
BP 51 TOUR MAINE MONTPARNASSE
33, AV .DU MAINE
75755, PARIS CEDEX 15, FRANCE
HOTLINE PHOTO NUMÉRIQUE :
00 800 22 26 37 27(Numéro Vert-Appel Gratuit)
TEL : (33) 1-4279-2200
FAX : (33) 1-4538-6858
www.samsungphoto.fr

SAMSUNG TECHWIN MOSCOW OFFICE
RUSSIA, 125167, MOSCOW LENNINGRADSKY,
PR-KT, 37-A, KORP14
TEL : (7) 095-258-9299/96/98
FAX : (7) 095-258-9297
http://www.samsungcamera.ru

TIANJIN SAMSUNG OPTO-ELECTRONICS CO.,LTD.
7 PINGCHANG ROAD NANKAI DIST., TIANJIN
P.R CHINA
POST CODE:300190
TEL : (86) 22-2761-8867
FAX : (86) 22-2761-8864
www.samsungcamera.com.cn
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